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Dev9K 1. Introduzione

1.1 - DESCRIZIONE GENERALE

Dev9K & un ambiente di sviluppo, operante in ambiente Windows®, per la progettazione ed il debug delle applicazioni basate sulle
Unita intelligenti della serie DAT9000. Grazie a questo software & possibile programmare le unita serie DAT9000 per eseguire
operazioni di lettura/scrittura degli /0 (serie DAT3000), operazioni logico/matematiche e timers. E' inoltre possibile leggere e
scrivere in tempo reale i registri interni del Controllore oppure collegarsi direttamente ai moduli slave collegati alla porta Modbus
Master dell' Unita intelligente stessa.

1.2 - REQUISITI MINIMI DI SISTEMA

Sistema Operativo Windows® 2000 / NT / ME / XP/ Vista
Spazio su Hard Disk 2 MB

1.3 - PROCEDURA DI INSTALLAZIONE

Assicurarsi che non ci siano applicazioni attive o in background.
* Inserire il CD-ROM di installazione nell' apposito driver.
« Attendere I' apertura della schermata di Autorun.
Se la funzione di Autorun & disabilitata sfogliare iI CD-ROM e lanciare la procedura di installazione aprendo la pagina al
seguente percorso:
<CD Driver>:/doc/download.html
« Cliccare sul pulsante Tools.
* Cliccare sul pulsante “download” nella sezione DAT9000.
« Seguire le indicazioni riportate nella procedura guidata di installazione.

1.4 - AMBIENTE DI SVILUPPO

All'interno della schermata principale dell'ambiente di sviluppo & possibile visualizzare:
* Le barre Menu, Pulsanti e Stato (Fig.1.1-A)

« La finestra relativa al Progetto (Fig.1.1-B)

* La finestra di Log (Fig.1.1-C)

* La finestra dell'Applicativo (Fig.1.1-D)

* La tabella dei Registri (Fig.1.1-E)

W DAT 9000
Project  Settings View Search
En = o R |
Dm—ﬂ|*: it i*‘*”llliﬂ|5§i0{}@5¢ﬂ”l
J— | | | |
A =2 BETA RELEASE =: :: BETA RELEASE :: = BETA RELEASE =:
Project [%] Program [%] Tabella Registri
B Project ain I MName Type R
tdzin Program Test Llnt ]
e 38 Controller [192.168 1172
-}% ontroller ! Firmware(0] Hex —
E| D Code P Firmware(1] Hex
. Mame[0] asCl
. Programma %) Mame[1] ASCI
B ] Commurication Hex
Address 0 ulnt
Timeout R 0 ulrt
Digital nputs Q0000000 00000000 | Bin
Digital Outputs Q0000000 00000000 | Bin
Coils 00000000 00000000 | Bin
Povierlp/S afe 00000000 00000000 | Bin
WwatchDog 0 ulnt
PC 0ooo
c Status{0] 00000000 00000000 | Bin

Statuz[1] 0 ulnt
COM Emors 0 ulnt
~Reserved-- 0 ulnt E
~Reserved-- 0 ulit
~Heserved- 0 ulnt
Timers Enable 00000000 00000000 | Bin

~Reserved- ulnt

ulrt
It

D Int

Int

Int

Int

Fig. 1.1
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]

1.5 - TERMINOLOGIA

Descrizione dei termini e delle abbreviazioni (in Italiano e in Inglese) utilizzate nell'ambiente di sviluppo e all'interno del presente
manuale:

Controllore Unita intelligente della serie DAT9000 da programmare.

Controller

Ambiente di Sviluppo| Software per la creazione dell'Applicativo, per il Debugging e per il Test.

IDE

Applicativo Elenco delle funzioni che il Controllore dovra eseguire.

Programma

Program

Blocco Funzione Ciascun blocco che compone I'Applicativo. Ogni Blocco Funzione pud contenere una Funzione.
Function Block

F.B.

Funzione Operazione logica, matematica o di flusso che deve essere eseguita dal Controllore.

Function

Argomento Ciascuna variabile (operatore) di una funzione.

Argument

Registro Posizione di una variabile all'interno della memoria volatile del Controllore.

Register

Registro Ritentivo Posizione di una variabile all'interno della memoria non volatile del Controllore

Etichetta Stringa di caratteri utilizzata per identificare il nome di un oggetto (blocco funzione, registro, tabella,...)
Label

1 VIV R Pag. 3



Dev9K 2. Creazione dell'Applicativo

2.1 - CREAZIONE DI UN NUOVO APPLICATIVO

Premere il pulsante “New Project’ (Fig.2.1-A) oppure selezionare il menu “ A B c ATy
Project -> New ”.

Verranno visualizzate le seguenti finestre: \ l /

-A. Finestra “Project’ con I'elenco delle proprieta del progetto (Fig.1.1-B). D = |

-B.Finestra “Program” con un primo blocco funzione vuoto. In questa

finestra & possibile inserire i blocchi funzione per creare I'applicativo (Fig.1.1- Fig. 2.1

D). o Save A5,
-C. Finestra “Registers” con l'elenco dei registri associati al Controllore Exit
(Fig.1.1-E). 0]

2.2 - SALVARE E CARICARE UN APPLICATIVO

In qualsiasi momento € possibile salvare il progetto premendo il pulsante | i
“Save Project” (Fig.2.1-C) oppure selezionando il menu “ Project -> Save " o “ W DAT 9000 . DAT 5000 LTy
Project -> Save As...". Project BEERcEN Froject BEica Froject B

Al primo salvataggio, verra richiesto il nome del file, che verra assunto (=

come nome del progetto.
Verranno creati i seguenti files: Close

* nomefile.prj — Contiene le informazioni riguardanti il progetto e g Save
I'applicativo Save fs... Save As...

* nomefile.lst — Contiene le informazioni riguardanti la tabella dei registri Exit Exit

* nomefiletbl — Contiene le informazioni riguardanti le tabelle di - L

linearizzazione

E' possibile caricare un progetto salvato in precedenza premendo il
pulsante “Open Project’ (Fig.2.1-B) oppure selezionando il menu “ Project ->
Open ”. Verranno caricati I'Applicativo, i nomi e i tipi dei registri e le
eventuali tabelle.

2.3 —INSERIMENTO, RIMOZIONE E MODIFICA DI BLOCCHI FUNZIONE

2.3 A: INSERIMENTO DI UN BLOCCO FUNZIONE

E' possibile inserire un nuovo blocco, all'interno del programma, prima o
dopo il blocco attivo.

Per attivare un blocco, cliccare all'interno del blocco stesso: il blocco attivo
sara evidenziato dal bordo rosso (Fig.2.3-A).

Premere il pulsante “Insert Before” (Fig.2.2-A) per inserire un blocco tra
quello attivo ed il precedente.

Premere il pulsante “Insert After’ (Fig.2.2-B) per inserire un blocco tra quello

© 2%

F o7
\ \ Fig. 2.2
cC D

>~ D'l'[l
® —— [

attivo ed il successivo. Il nuovo blocco inserito verra attivato Program &
automaticamente. =] B
b air Program \E
2.3 B: RIMOZIONE DI UN BLOCCO FUNZIONE
Premere il pulsante “Delete” (Fig.2.2-D) per rimuovere il blocco attivo. (1l ]
Per modificare una funzione, cliccare sul blocco desiderato per attivarlo (il Device DATSITIE mﬁ’ﬂ Anslogln Resouce
blocco attivo & evidenziato da un bordo rosso). Successivamente premere oh [
il pulsante “Modify” (Fig.2.2-C) oppure fare doppio-click sul blocco. s
Le funzioni descritte precedentemente sono accessibili anche tramite il 2

menu a tendina (tasto destro del mouse all'interno del blocco funzione).

Il pulsante “Zoom” (Fig.2.3-B) consente di ridurre le dimensioni dei blocchi
funzioni per permettere la visualizzazione di piu blocchi all'interno della
finestra.

Fig. 2.3
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Dev9K

2.3 C: MODIFICA DI UN BLOCCO FUNZIONE

Quando si modifica un Blocco Funzione, viene visualizzata la finestra
“Function Block” (Fig.2.4), che permette l'inserimento degli Argomenti relativi
alla funzione che verra eseguita all'interno dell'applicativo.

Le Funzioni sono state raggruppate in gruppi funzionali: selezionando il
pulsante relativo ad un gruppo funzionale (Fig.2.4-A), vengono visualizzate le
funzioni che fanno parte di quel gruppo (Fig.2.4-B). Selezionando il pulsante
relativo alla funzione desiderata, & possibile inserire I'etichetta (Label) e gl
eventuali Argomenti (Fig.2.4-C) propri di quella funzione.

Per inserire argomenti di tipo particolare quali maschere o tabelle, &
disponibile il pulsante “Set ” per aprire una finestra di inserimento guidato
del valore.

Al termine, premere il pulsante “OK” (Fig.2.4-D) per inserire la funzione
all'interno dell'applicativo.

All'interno del Blocco Funzione, saranno visualizzati i seguenti parametri:

* Indice (Fig.2.5-A): numero univoco che identifica la posizione all'interno del
programma.

» Label (Fig.2.5-B): Etichetta univoca che identifica il blocco funzione
all'interno del programma (utilizzata per le funzioni del gruppo Flow, c.f.r.
Sez. “Descrizione Funzioni”)

» Simbolo (Fig.2.5-C): Simbolo della funzione inserita

» Argomenti (Fig.2.5-D): Argomenti della funzione inserita

Fare riferimento alla sezione “Descrizione Funzioni” per la modalita di
inserimento delle diverse funzioni.

Function Block

2. Creazione dell'Applicativo

2.4 - COMPILAZIONE e CONTROLLO DEGLI ERRORI

Dopo aver inserito i blocchi funzione, &€ possibile compilare I'applicativo
premendo il pulsante “Compile ” (Fig.2.6).

Verra creato un report nella finestra Log (Fig.2.7) contenente gli eventuali
errori 0 anomalie riscontrate all'interno del programma (Fig.2.7-A). Se la
compilazione va a buon fine, verra riportato il volume delle risorse utilizzate
(Fig.2.7-B).

Functions Options
Move | Bitwise | Shift Read DAT3000
Math | Comp | Flow | Timers Label
- - - Device [DATA0N4 | [urt |
Address [1 = [uin ~|
\ Fiesource [Analog In | [t |
B From [0 ST =]
To [0 | [uin |
Dest. [%R26 ~| [ir ~|
Delay 10 / oK
p” Fig.24

/C

A /

1

Fig. 2.6

Device DATI018

Address 1 gﬂbﬂ

/

Analog ln Hesource
1] Framn
1]

To
#R22  Dest Inf

Fig. 2.5

N

- 11/06/200911.38.35 -
Compiling ...
A Emor Check : Failed
Cormpile Error
- Rung 3 Label emor
- 11/06/200911.39.32 -
Compiling ...
Ermor Check. : OF,
B Memon Uzage
Program 17 &
FProcess 15 %

Fig. 2.7
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3.1 - REGISTRI INTERNI

La memoria interna del Controllore & rappresentata da una serie di Registri
a 16 bit in ram, suddivisi nei seguenti tipi:

%S Registri di Sistema: contengono le informazioni riguardanti lo
stato del Controllore.
%R Registri General Purpose: possono essere utilizzati

dall'Applicativo per il movimento dei dati o per eseguire le
funzioni di calcolo.

Registri General Purpose Ritentivi: possono essere utilizzati
dall'Applicativo per il movimento dei dati o per eseguire le
funzioni di calcolo. Questi registri vengono salvati in Eprom
ogni volta che si verifica una variazione del loro valore e
caricati in ram ad ogni accensione del Controllore.

Premere il pulsante “Watch” (Fig.3.1) per visualizzare la Tabella dei Registri
(Fig.3.2).

Per aggiornare il valore dei registri, premere il pulsante “Read” (Fig.3.2-A).
Per ogni registro viene visualizzato:

* L'indirizzo del registro (Fig.3.2-B)

* Il Nome del registro (Fig.3.2-C)

« Il Valore contenuto nel registro (Fig.3.2-D)

« Il Formato del registro (Fig.3.2-E)

Per modificare il nome o il valore di un registro, fare doppio-click sul
registro stesso. All'interno della finestra “Set” (Fig.3.3) € possibile indicare il
Nome del registro (solo per i registri General Purpose), forzare il Valore
contenuto (se il Controllore € collegato) ed indicare il Formato del registro.

3.2 - FORMATO DATI

Ogni registro General Purpose pud essere letto o scritto in uno dei seguenti
formati:

* Uint Intero (16bit) senza segno (0 + 65535)

e Int Intero (16bit) con segno (-32768 + +32767)

« Ulong Long (32bit) senza segno (0 + 4.294.967.295)

e Long Long (32bit) con segno (-2.147.483.648 + +2.147.483.647)
* Float Floating Point (32bit)

* Hex Intero (16bit) visualizzato in Esadecimale (0000 + FFFF)

« ASCII Intero (16bit) visualizzato in caratteri ASCII

* Bin Intero (16bit) visualizzato in codice binario

* K _Fit Costante Floating Point (decimale)

K Long Costante Long (binario)

NOTA: | registri con formato a 32 bit occupano la posizione di 2 registri.

Fig. 3.1

B Cc

3. Registri Interni

Registers Table
Reg MHarne
] ~-Reserved- il ulnt -
2 Firrnware] 0] ] Hex j
Py Firrnware[1] 0nao Hex
] M arne0] ASCI
%54 Mame[1] A5CI
¥5F Part 1 Settings aaoo Hes
%5E Address i] LIkt
%57 Port 1 Timeout 1] Lkt
P Digital Inputs 00000000 00000000 | Bin
%5 Digital Dutputs 00000000 00000000 | Bin
%510 System Flags 00000000 00000000 | Bin
eqq ~Reserved- a At
%512 Wi atchDog i ulit
%513 FC nooo Hex
%014 Statuz[0] 00000000 00000000 | Bin
%515 Statuz[1] i] it
el = COk Errars 0 ulnt
Eeak Gatewsay Mask[L-H] ] Hex
%Cg Fort 0 Settings 0 ulnt
%5{q port 0 Settingz a LAt
el Timerz Enable Q0000000 00000000 | Bin
eaq ~Reserved- a At
%522 RTC[Sec] oo Hex
Pateie] RTCMin/Haurs] ] Hex
sty RTC[D aw/D ate] ] Hex
¥5IR RTC[Monthdvear] 00oo Hex
%R26 0 Int
%R27 0 Int
%R28 0 Ik
%R29 0 Int
ZR30 0 Ik
ZR3 0 Int
ZR32 0 Int
ZR33 0 Int
%R34 0 Int j'
|
Fig. 3.2
set ®
%R24
Label Type
|Input #O |Int j
Yalue :
[1270
Annulla | [

Fig. 3.3
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3.3 - MAPPATURA REGISTRI

| MODELLO DAT9000-DL-IO — Ver.FW 9000 |

Registro Descrizione Accesso
%S0 --Reserved-- R/W
%S1 Firmware [0] R
%S2 Firmware [1] R
%S3 Name [0] R/W
%S4 Name [1] R/W
%S5 Port 1 [BaudRate] R/W
%S6 Node ID R/W
%S7 Port 1 [Timeout RX] R/W
%S8 Digital Inputs R/W
%S9 Digital Outputs R/W
%S10 System Flags R/W
%S11 --Reserved-- -
%S12 --Reserved-- -
%S13 PC R
%S14 Status [0] R
%S15 Status [1] R
%S16 COM Errors R/W
%S17 Gateway Mask [L-H] R/W
%S18 Port 0 [Settings] R/W
%S19 Port 0 [Settings] R/W
%S20 Timers Enable R/W
%S21 --Reserved-- -
%R22 RTC [0] R/W
%R23 RTC [1] R/W
%R24 RTC [2] R/W
%R25 RTC [3] R/W
%R26 General R/W

Purpose

Registers
%R959
%R960 Memory R/W

Registers
%R1023

3.4 — DESCRIZIONE REGISTRI DI SISTEMA

Viene descritto di seguito il funzionamento dei registri di Sistema. Fare riferimento alla Mappatura dei Registri relativa al
dispositivo in uso per la posizione e I'accesso del registro.

Campo di 2 registri di sola lettura, che contiene l'identificativo firmware dato dal costruttore.

Campo di 2 registri (4 byte o 4 caratteri ASCII) a disposizione dell’'utente, pud contenere il nome dell’apparato o una sigla che
ne identifica la funzione all'interno dell'impianto. Ciascuno dei 4 byte pud contenere qualsiasi valore da 0 a 255, quindi anche
caratteri ASCII.

Il valore di default di questo campo contiene l'identificativo del modulo in caratteri ASCII.

PORT 1 BaudRate

Impostare il valore di questo registro secondo la tabella seguente, per selezionare il baud-rate della porta seriale PORT 1
(Modbus Master).

BaudRate| Valore
1200
2400
4800
9600
19200

38400
57600
115200

N[O~ WN = O
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Dev9K 3. Registri Interni

Contiene l'indirizzo di nodo Modbus del modulo; sono permessi gli indirizzi da 1 a 247.
Ogni modulo connesso alla stessa rete deve avere un indirizzo univoco.

PORT 1 Timeout RX

Indica il valore del tempo di ritardo successivo alla ricezione della risposta sulla porta Modbus Master, espresso in
millisecondi.

DIGITAL INPUTS

Questo registro mostra lo stato degli ingressi digitali (0 = OFF , 1 = ON).
Bit 15‘14‘13‘12 11 ‘10‘09‘08 07‘06‘05‘04 03‘02‘01 ‘00
Descr. Input
Canale | - | - | - | - [#3|#2 #1 |#0 | - | - | - | - | - | - | - | -

DIGITAL OUTPUTS

Questo registro permette di comandare direttamente lo stato dei relé di uscita (0 = OFF ; 1 = ON).

Bit 15\14‘13\12 11‘10‘09‘08 07‘06‘05‘04 03‘02\01\00
Descr. Output
Canale | - | - | - | - | = | - |#1|#O0| - | - | = | = | = | - | - | -

SYSTEM FLAGS

Questo registro contiene i flag di sistema descritti di seguito.
- PowerUp Event : questo bit viene forzato a 1 ad ogni accensione del dispositivo. E' possibile impostare il valore a 0 per
intercettare un eventuale reset del dispositivo.

Bit 15|14 /1312|1110 09|08 |07 |06 | 05|04 |03 | 02|01 |00

Coil | - | -] - - WEPU| - |- |-|-|-|-]-|-1]-]-

L

PowerUp Event
Normal Mode
Evento PowerUp

N elas]

Watchdog Enable
Watchdog disabiltato
Watchdog abilitato

- O

PC (Program Counter

Questo registro indica la posizione del programma applicativo (istruzione da eseguire). Il valore 0 indica la prima istruzione
(Blocco Funzione 1).

STATUS

Registri riservati per la diagnostica.

COM ERRORS

Contatore degli errori di comunicazione sulla porta Master. Il valore di questo registro viene incrementato ogni volta che viene
inviato un comando Modbus sulla porta master e non viene ricevuta una risposta.
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3. Registri Interni

GATEWAY MASK

In questo registro & possibile specificare I'intervallo di indirizzi modbus che il Controllore puo interrogare sulla porta Master. Se
viene richiesto al Controllore di interrogare un dispositivo il cui indirizzo non rientra nella maschera, il comando verra ignorato.

Bit 15‘14‘13‘12‘11‘10‘09‘08

07‘06‘05‘04‘03‘02‘01‘00

Descr. Indirizzo iniziale della maschera

Indirizzo finale della maschera

PORT 0 Settings

Impostare il valore di questo registro secondo la tabella seguente, per selezionare il baud-rate ed il tempo di delay (espresso
in ms.) della porta seriale PORT 0 (Modbus Slave).

Bit 15‘14‘13‘12‘11‘10‘09‘08

07‘06‘05‘04‘03‘02‘01‘00

Baud Rate

Descr.

Delay (0+255)

BaudRate

Valore

1200
2400
4800
9600
19200
38400
57600
115200

N[O WIN |- O

TIMERS Enable

Ogni bit di questo registro & associato ad un Timer interno.
Il timer inizia a contare nel momento in cui il relativo bit viene impostato a 0. Trascorso il tempo specificato per il timer (tramite
il relativo Blocco Funzione), lo stesso bit viene automaticamente forzato a 1, indicando che il timer & arrivato a fine conteggio.

Bit 15\14‘13\12\11 ‘10‘09‘08‘07‘06‘05‘04‘03‘02‘01 ‘00
Descr. Tirr‘1ers
Canale |T7|T6|T5|T4 ‘ T3|[T2|T1|TO0 ‘T15 T14[T13 T12‘T11 T10/T9 | T8

RTC (Real Time Clock/Calendar)

Sono disponibili le seguenti informazioni:
Centesimi di secondo 00 + 99

Secondi 00 + 59
Minuti 00 + 59
Ore 00 =23
Giorno 01 +07 (
Data 01+ 31 (
Mese 01+12(
Anno 00 + 99 (

Campo di 4 registri contenenti il valore dell'orologio interno(disponibile solo per i modelli DAT9000DL e DAT9000DLIO).

01=Domenica, 02=Lunedj, .... 07=Sabato)
dipende dal mese)

01=Gennaio, 02=Febbraio, .... 12=Dicembre)
00=2000, 99=2099)

NOTA: Tutti i valori sono espressi in caratteri esadecimali.
ATTENZIONE! La scrittura su questi registri implica la variazione dell'impostazione dell'orologio e del calendario.

Bit 15‘14‘13‘12‘11 ‘10‘09‘08 07‘06‘05‘04‘03‘02‘01 ‘00
RTC[0] 1/100 Sec. Secondi [0+59]

RTC[1] Minuti [0+59] Ore [0+23]

RTCI[2] Giorno [1+7] Data [1+31]

RTC[3] Mese [1+12] Anno [0+99]
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Dev9K 4. Descrizione Funzioni

4.1 - ELENCO FUNZIONI

Albero di selezione delle funzioni che si possono inserire nel blocchi dell'applicativo, suddivise per gruppi funzionali:

COMM | Funzioni di comunicazione

Rea!d Funzione Modbus “Read Holding Registers” (4xxxx , comando 0x03)
Holding
E“:ﬁ]‘: Funzione Modbus “Read Input Registers” (3xxxx , comando 0x04)
Write Funzione Modbus “Write Holding Registers” (4xxxx , comando 0x16)
Read Funzione di lettura valori da moduli serie DAT 3000
DAT 3000
Write Funzione di scrittura valori da moduli serie DAT 3000
DAT 3000

MOVE | Movimento valori
Copia il valore di un registro interno o una costante sul registro di destinazione

m Logica Booleana

m Funzione AND tra due bit

m Funzione OR tra due bit

m Funzione XOR tra due bit

Funzione AND tra due word (registri)
LTI Funzione OR tra due word (registri)

Funzione XOR tra due word (registri)

—ICEl Negazione di uno o piu bit

m Forza a 1 uno o piu bit

Forza a 0 uno o pitl bit

SIS | ogica Booleana

m Funzione “Shift verso destra” di una word (registro)
m Funzione “Shift verso sinistra” di una word (registro)

UL Funzione “Rotate verso destra” di una word (registro)

NG Funzione “Rotate verso sinistra” di una word (registro)

MATH | Operazioni Matematiche

m Somma di due valori
m Differenza di due valori
m Moltiplicazione di due valori
Divisione di due valori
Adattamento proporzionale di scala
Estrazione di radice quadra
Calcola la media aritmetica di due o piu valori
Linearizza un valore secondo una tabella custom
m Restituisce il valore assoluto di un valore
Calcolo esponenziale
Elevazione a potenza

Pag. 10




Dev9K 4. Descrizione Funzioni

Funzioni di comparazione

Soglia di massima

_ Controllo di flusso dell'applicativo

_ Salto incondizionato
_ Salto condizionato
_ Salto ad una subroutine
_ Return da una subroutine

Funzioni di temporizzazione

Timer monostabile
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4. Descrizione Funzioni

4.2 - DESCRIZIONE FUNZIONI

Read Lettura registri da modulo Modbus Slave generico
Legge il valore di N registri da un modulo Modbus slave generico e scrive i valori letti nei registri interni. In
»H caso di mancata ricezione della risposta o di risposta errata da parte del modulo, i registri di destinazione non
vengono modificati e viene incrementato il registro di sistema “COM Errors”.
Argomenti:
Address Indirizzo Modbus del modulo Slave (1+247)
Register Indirizzo del primo registro da leggere (la mappatura dei registri parte da 0)
Num Numero di registri da leggere (1+16)
Dest Registro interno a partire dal quale verranno scritti i valori letti
Delay Tempo di ritardo tra la ricezione della risposta e I'esecuzione della successiva istruzione
Write Scrittura registri su modulo Modbus Slave generico
Scrive su un modulo Modbus slave generico i valori di N registri interni. In caso di mancata ricezione della
H* risposta o di risposta errata da parte del modulo, i registri di destinazione non vengono modificati e viene
incrementato il registro di sistema “COM Errors”.
Argomenti:
Address Indirizzo Modbus del modulo Slave (1+247)
Register Indirizzo del primo registro da scrivere (la mappatura dei registri parte da 0)
Num Numero di registri da scrivere (1+16)
Source Registro interno a partire dal quale verranno prelevati i valori da scrivere
Delay Tempo di ritardo tra la ricezione della risposta e I'esecuzione della successiva istruzione
Read3000 ‘Lettura registri da modulo Modbus Slave serie DAT3000

=0

Legge il valore degli I/O da un modulo Modbus slave della serie DAT3000 e scrive i valori letti nei registri
interni. La funzione provvedera a creare il corretto comando Modbus e ad elaborare la risposta. In caso di
mancata ricezione della risposta o di risposta errata da parte del modulo, i registri di destinazione non
vengono modificati e viene incrementato il registro di sistema “COM Errors”.

Fare riferimento alla documentazione tecnica del modulo per la descrizione completa dei relativi registri di 1/O

Argomenti:

Device Tipo di modulo

Address Indirizzo Modbus del modulo Slave (1+247)

Resource Tipo della risorsa da leggere (ingressi analogici, ingressi digitali, ecc...)

From Prima risorsa da leggere

To Ultima risorsa da leggere

Dest Registro interno a partire dal quale verranno scritti i valori letti

Delay Tempo di ritardo tra la ricezione della risposta e I'esecuzione della successiva istruzione
Write3000 Scrittura registri su modulo Modbus Slave serie DAT3000

B

Scrive il valore degli 1/0 di un modulo Modbus slave della serie DAT3000 rispetto ai valori letti nei registri
interni. La funzione provvedera a creare il corretto comando Modbus e ad elaborare la risposta. In caso di
mancata ricezione della risposta o di risposta errata da parte del modulo, i registri di destinazione non
vengono modificati e viene incrementato il registro di sistema “COM Errors”.

Fare riferimento alla documentazione tecnica del modulo per la descrizione completa dei relativi registri di I/O

Argomenti:

Device
Address
Resource
From

To
Source
Delay

Tipo di modulo

Indirizzo Modbus del modulo Slave (1+247)

Tipo della risorsa da scrivere (uscite analogiche, uscite digitali, ecc...)

Prima risorsa da scrivere

Ultima risorsa da scrivere

Registro interno a partire dal quale verranno prelevati i valori da scrivere

Tempo di ritardo tra la ricezione della risposta e I'esecuzione della successiva istruzione
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4. Descrizione Funzioni

Move Sposta in un registro un valore costante o il valore di un altro registro

Scrive su un registro il valore di una costante (preset) o il valore di un altro registro (copia). Il valore verra
» convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro sorgente e del registro

destinazione possono coincidere (modifica del formato di un registro).

Argomenti:

Source Costante o Registro interno dal quale verra letto il valore

Dest Registro interno sul quale verra scritto il valore

And (word) Esegue lI'operazione logica And tra due valori

Esegue l'operazione logica AND tra un registro ed una costante (mascheratura) oppure tra due registri. Il
valore verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro sorgente e
del registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver eseguito
I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno modificati.
Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione sia di 16 bit
(intero), i bit piu significativi verranno ignorati. E' possibile utilizzare questa funzione per forzare uno o piu bit di
un registro al valore 0 (impostare a 0 nella costante i bit da forzare a 0 e impostare a 1 i bit da non modificare).

Argomenti:

Source A Costante o Registro del primo operatore
Source B Costante o Registro del secondo operatore
Mask Out Maschera applicata al risultato

Dest Registro interno sul quale verra scritto il risultato
Or (word) Esegue I'operazione logica Or tra due valori

Esegue l'operazione logica OR tra un registro ed una costante (mascheratura) oppure tra due registri. Il valore
verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro sorgente e del
registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver eseguito
I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno modificati.
Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione sia di 16 bit
(intero), i bit piu significativi verranno ignorati. E' possibile utilizzare questa funzione per forzare uno o piu bit di
un registro al valore 1 (impostare a 1 nella costante i bit da forzare a 1 e impostare a 0 i bit da non modificare).

Argomenti:

Source A Costante o Registro del primo operatore

Source B Costante o Registro del secondo operatore

Mask Maschera applicata al risultato

Dest Registro interno sul quale verra scritto il risultato

Xor (word) Esegue I'operazione logica XOr (OR Esclusiva) tra due valori
Esegue I'operazione logica XOR tra un registro ed una costante (mascheratura) oppure tra due registri. |l
valore verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro sorgente e
del registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver eseguito

X0R I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno modificati.

Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione sia di 16 bit
(intero), i bit piu significativi verranno ignorati. E' possibile utilizzare questa funzione per negare (NOT) uno o
piu bit di un registro (impostare a 1 nella costante i bit da negare e impostare a 0 i bit da non modificare).

Argomenti:

Source A Costante o Registro del primo operatore

Source B Costante o Registro del secondo operatore

Mask Maschera applicata al risultato

Dest Registro interno sul quale verra scritto il risultato
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And (bit) ‘Esegue I'operazione logica And tra due bit

Esegue l'operazione logica AND (bit a bit) tra un registro ed una costante (mascheratura) oppure tra due
registri. Il valore verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro
sorgente e del registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver

eseguito I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno
modificati. Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione
sia di 16 bit (intero), i bit piu significativi verranno ignorati.

Argomenti:

Source A Costante o Registro del primo operatore

Mask A Bit del primo operatore

Source B Costante o Registro del secondo operatore
Mask A Bit del secondo operatore

Dest Registro interno sul quale verra scritto il risultato
Mask Out Maschera applicata al Registro di destinazione
Or (bit) Esegue l'operazione logica Or tra due bit

Esegue l'operazione logica OR (bit a bit) tra un registro ed una costante (mascheratura) oppure tra due
registri. Il valore verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro
sorgente e del registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver

eseguito I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno
modificati. Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione
sia di 16 bit (intero), i bit piu significativi verranno ignorati.

Argomenti:

Source A Costante o Registro del primo operatore

Mask A Bit del primo operatore

Source B Costante o Registro del secondo operatore

Mask A Bit del secondo operatore

Dest Registro interno sul quale verra scritto il risultato

Mask Out Maschera applicata al Registro di destinazione

XOr (bit) Esegue I'operazione logica XOr (OR Esclusiva) tra due bit

Esegue l'operazione logica XOR (bit a bit) tra un registro ed una costante (mascheratura) oppure tra due
registri. Il valore verra convertito nel formato selezionato per il registro di destinazione. L'indirizzo del registro
sorgente e del registro destinazione possono coincidere (modifica del formato di un registro). Dopo aver
eseguito I'operazione logica, verranno forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno
modificati. Nel caso in cui il registro sorgente o la costante siano di 32 bit (long) ed il registro di destinazione
sia di 16 bit (intero), i bit piu significativi verranno ignorati.

Argomenti:
Source A Costante o Registro del primo operatore
Mask A Bit del primo operatore
Source B Costante o Registro del secondo operatore
Mask A Bit del secondo operatore
Dest Registro interno sul quale verra scritto il risultato
Mask Out Maschera applicata al Registro di destinazione
NOT ‘Esegue la negazione dei bit di un registro
Esegue la negazione dei bit di un registropiu significativo. Dopo aver eseguito l'operazione logica, verranno
forzati solo i bit impostati a 1 nella maschera, gli altri bit non saranno modificati.
Argomenti:
Source Registro dal quale verra letto il valore
Dest Registro interno sul quale verra scritto il risultato
Mask Out Maschera applicata al Registro di destinazione
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4. Descrizione Funzioni

Shift R Sposta i bit di un registro verso destra
Esegue lo shift di un registro verso destra: tutti i bit vengono spostati di N posizioni verso destra. | bit piu
significativi verranno forzati a 0.
Argomenti:
Source Registro dal quale verra letto il valore
N Numero di spostamenti da effettuare
Dest Registro interno sul quale verra scritto il risultato
Shift L ‘Sposta i bit di un registro verso sinistra
Esegue lo shift di un registro verso sinistra: tutti i bit vengono spostati di N posizioni verso sinistra. | bit meno
significativi verranno forzati a 0.
Argomenti:
Source Registro dal quale verra letto il valore
N Numero di spostamenti da effettuare
Dest Registro interno sul quale verra scritto il risultato
Rotate R Ruota i bit di un registro verso destra

Esegue la rotazione di un registro verso destra: tutti i bit vengono spostati di N posizioni verso destra. Ad ogni
spostamento, il bit piu significativo riceve il valore del bit meno significativo.

Argomenti:

Source Registro dal quale verra letto il valore

N Numero di spostamenti da effettuare

Dest Registro interno sul quale verra scritto il risultato
Rotate L Ruota i bit di un registro verso sinistra

Esegue la rotazione di un registro verso sinistra: tutti i bit vengono spostati di N posizioni verso sinistra. Ad
ogni spostamento, il bit meno significativo riceve il valore del bit piu significativo.

Source
N
Dest

Argomenti:

Registro dal quale verra letto il valore
Numero di spostamenti da effettuare
Registro interno sul quale verra scritto il risultato
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4. Descrizione Funzioni

Add Calcola la Somma di due valori
Calcola la somma tra un registro e una costante o tra due registri
+
Argomenti:
Source A Costante o Registro del primo operatore
Source B Costante o Registro del secondo operatore
Dest Registro interno sul quale verra scritto il risultato
Sub Calcola la Differenza di due valori
Calcola la differenza tra un registro e una costante o tra due registri
Argomenti:
Source A Costante o Registro del primo operatore
Source B Costante o Registro del secondo operatore
Dest Registro interno sul quale verra scritto il risultato
Mult Calcola la Moltiplicazione tra due valori

X

Calcola la moltiplicazione tra un registro e una costante o tra due registri

Argomenti:

Source A Costante o Registro del primo operatore
Source B Costante o Registro del secondo operatore
Dest Registro interno sul quale verra scritto il risultato
Div

‘Calcola il Rapporto tra due valori

7/

Calcola il rapporto tra un registro e una costante o tra due registri

Source A
Source B
Dest

Argomenti:

Costante o Registro del primo operatore
Costante o Registro del secondo operatore
Registro interno sul quale verra scritto il risultato
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4. Descrizione Funzioni

Scale

Calcola la scalatura proporzionale di un valore

=]

Calcola la scalatura proporzionale di un valore dal campo-scala di ingresso al campo-scala di uscita.

Argomenti:

Source Registro di ingresso

Span In Valore massimo della scala di ingresso
ZeroIn Valore minimo della scala di ingresso
Dest Registro di uscita

Span Out Valore massimo della scala di uscita
Zero Out Valore minimo della scala di ingresso
SQRT Calcola la radice quadrata di un valore

=

Calcola la radice quadrata del valore contenuto in un registro.

Argomenti:
Source Registro di ingresso
Dest Registro interno sul quale verra scritto il risultato
Average Calcola la media di N registri
Calcola la media aritmetica semplice del valore di N registri (somma dei valori / N).
AYG
Argomenti:
Source Indirizzo del primo Registro
N Numero di registri su cui effettuare la media
Dest Registro interno sul quale verra scritto il risultato

Linearization

Trasforma un valore secondo una curva di linearizzazione

=l

Calcola la linearizzazione di un valore secondo la curva inserita. Fare riferimento alla sezione “Tabelle” per
ulteriori informazioni.

Argomenti:

Source
Function
Dest

Registro di ingresso
Nome della tabella che contiene la curva di linearizzazione
Registro interno sul quale verra scritto il risultato

1S O IV VAR 1 Pag. 17



Dev9K

4. Descrizione Funzioni

Trip

Gestisce una soglia di allarme

Gestisce una soglia di allarme con isteresi e tempo di delay all'inserzione e alla disinserzione. Se il valore di
ingresso supera la soglia alta per un tempo maggiore di Ton, vengono forzati a 1 i bit dell'uscita indicati nella
maschera. Se il valore di ingresso scende sotto la soglia bassa per un tempo maggiore di Toff, vengono
forzati a 0 i bit dell'uscita indicati nella maschera.

E' possibile utilizzare questa funzione per eseguire la funzione semplice “A>B”, impostando le due soglie
uguali ed il tempo Ton e Toff = 0.

NOTA: lo stato dell'uscita viene aggiornato, dopo la fine del tempo di delay, ad ogni esecuzione della funzione
“Trip”: si consiglia quindi di inserire questo blocco funzione in una zona dell'applicativo eseguita in
continuazione.

L'esempio (Fig.4.1) mostra il funzionamento di una soglia di allarme che si attiva se il segnale di ingresso
supera i 100°C per almeno 2 secondi e si disattiva se il segnale di ingresso scende sotto 90°C per almeno 5
secondi.

100 —\ Max
Input
920 \/ / Min
Output
(bit dest.)
Ton Toff
(2 sec.) (5 sec.) Fig. 4.1

Argomenti:

Input

Max

Min

Dest
Mask

Use Timer
Timer On
Timer Off

Registro di ingresso

Soglia Alta

Soglia Bassa

Registro interno sul quale verra scritto il risultato
Maschera applicata al risultato

Numero del Timer da utilizzare (0+15)

Tempo di delay all'inserzione (ms)

Tempo di delay alla disinserzione (ms)
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Goto if False

Goto Salto incondizionato ad un blocco funzione
Esegue un salto incondizionato ad un blocco funzione. Il blocco funzione chiamato deve avere un'etichetta
(Label) univoca. E' possibile selezionare una delle etichette disponibili nel menu a tendina.
Goto
Argomenti:
Func.Block  Puntatore al blocco funzione
If (bit) Salto ad un blocco funzione condizionato dallo stato dell bit di ingresso
Se lo stato del bit indicato del registro di ingresso & 1, esegue un salto al blocco funzione indicato nel campo
“Goto if true”. Se lo stato del bit indicato del registro di ingresso & 0, esegue un salto al blocco funzione
e indicato nel campo “Goto if false”.
2 Il blocco funzione chiamato deve avere un'etichetta (Label) univoca. E' possibile selezionare una delle
etichette disponibili nel menu a tendina.
Argomenti:
Source Registro di ingresso
Bit Numero del bit da controllare (0+15)
Goto if True  Puntatore al blocco funzione (se bit=1)

Puntatore al blocco funzione (se bit=0)

Call Chiama una Subroutine
Esegue un salto al primo blocco funzione di una subroutine. Al termine della subroutine (terminata con il
comando Return) verra eseguito il blocco funzione successivo a questo. Il blocco funzione chiamato deve
i avere un'etichetta (Label) univoca. E' possibile selezionare una delle etichette disponibili nel menu a tendina.
a2 Attenzione: ogni chiamata ad una subroutine deve corrispondere con un comando di return, altrimenti &
possibile incorrere in un errore di “Stack Overflow” (fare riferimento alla sezione “Throubleshooting”)
Argomenti:
Func.Block  Puntatore al blocco funzione
Return Ritorno da una Subroutine
Indica la fine di una subroutine. Il programma ritornera al blocco successivo a quello che ha chiamato la
i r subroutine (comando “Call”)
Return Attenzione: ogni chiamata ad una subroutine deve corrispondere con un comando di return, altrimenti &
possibile incorrere in un errore di “Stack Overflow” (fare riferimento alla sezione “Throubleshooting”)

_Abilita un Timer

Imposta un timer ed inizia il conteggio. Durante il conteggio, il bit relativo al timer nel registro di sistema
“Timers Enable” verra forzato a 0. Al termine del tempo impostato, il bit verra forzato a 1. E' possibile
monitorare lo stato del bit per individuare la fine del tempo impostato.

Argomenti:

Timer
mSec

Numero del Timer da abilitare
Preset del Timer (ms)
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5. Tabelle

5.1 — INSERIMENTO TABELLE

Per inserire le tabelle di linearizzazione, aprire la finestra di inserimento
(Fig.5.1) selezionando il menu “Tools -> Tables”.

Per caricare i punti della tabella da un file, premere il pulsante “Load from
File” (Fig.5.1-A): verranno caricati il nome della tabella, il numero di punti ed i
valori di ingresso e uscita per ogni punto.

E' possibile modificare il Nome della tabella (Fig.5.1-B) (il nome dovra essere
univoco, in quanto sara utilizzato all'interno dell'Applicativo per richiamare
la tabella stessa). Indicare il numero di punti da inserire nella tabella (Fig.5.1-
C).

E' possibile inserire fino a 32 punti. Ogni punto & definito dal valore di
ingresso e dal valore di uscita. | valori di ingresso devono essere inseriti in
ordine crescente, mentre i valori di uscita possono anche non essere
ordinati. L'esempio (Fig.5.1-D) mostra come inserire nella tabella i valori della
curva caratteristica di un sensore di temperatura (Fig.5.2) per la conversione
da Ohm a °C.

Esempio di tabella °C Curva Caratteristica
fornita dal costruttore 70
del sensore : )
°C Ohm 60 [A
0 1000 50
15 [11456 © /
20 1367,3 /
25 1532,7 %0 /
30 1673,4 20
40 [19045 ol P
50 1966,3 /
0~ ¢ T T T T \ \
60 2000 800 1000 1200 1400 1600 1800 2000 2200
Ohm
Fig. 5.2

Terminato l'inserimento dei punti, & possibile salvare i punti della tabella in
un file, premendo il pulsante “Save to File” (Fig.5.1-E): verranno salvati il
nome della tabella, il numero di punti ed i valori di ingresso e uscita per
ogni punto.

Premere il pulsante “>>” (Fig.5.1-F) per inserire la tabella appena creata
all'interno dell'applicativo. L'elenco “Table List’(Fig.5.1G) mostra le tabelle gia
inserite nell'applicativo. Le curve inserite verranno salvate e caricate nei file
di progetto.

All'interno dell'Applicativo, quando si inserisce in un blocco funzione la
funzione “Linearization” & possibile selezionare una delle curve inserite.

Nel momento in cui l'applicativo richiama il blocco funzione, il Controllore
esegue un controllo tra il valore contenuto nel registro di ingresso e la
tabella specificata e, per interpolazione, calcola il valore di uscita.
Nell'esempio, per un valore di ingresso di 1789 Ohm, verra calcolata
l'uscita di 35°C (senza la funzione di linearizzazione, la conversione
avrebbe fornito l'uscita di 47,3°C).
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6.1 — RICERCA DEI DISPOSITIVI CONNESSI

Collegare il Controllore alla rete Ethernet ed alimentarlo (fare riferimento al
relativo datasheet).

Selezionare il menu “Tools -> Search” , si apre la finestra “Search” (Fig.6.1)
E' possibile selezionare il tipo di Controllore da ricercare (Fig.6.1-A) ed il
timeout di ricezione (tempo oltre il quale il dispositivo viene ritenuto non
connesso) (Fig.6.1-B).

E' possibile inoltre ricercare eventuali moduli collegati alla porta Modbus-
master del Controllore Ethernet, indicando l'intervallo di indirizzi da
controllare (Fig.6.1-C); per utilizzare questa funzionalita, assicurarsi che il
Controllore della serie DAT9000 sia in modalita “Debug” e in condizione di
“Stop”).

Per iniziare la ricerca, premere il pulsante “Search” (Fig.6.1-D). In qualsiasi
momento € possibile interrompere la ricerca premendo il pulsante “Stop”.
Ogni volta che viene riconosciuto un Controllore compatibile con il tipo
indicato, esso viene visualizzato nella lista (Fig.6.1-E), dove sara possibile
leggere il relativo indirizzo IP, il numero MAC e l'indirizzo del nodo Modbus.
Successivamente (se richiesto) verranno ricercati i moduli Modbus-slave
collegati allo stesso Controllore. | moduli riconosciuti verranno visualizzati
nella lista (Fig.6.1-F), dove sara possibile leggere il relativo indirizzo del nodo
Modbus e, in caso di moduli della serie DAT3000, l'indicativo del Firmware.
Al termine della ricerca, & possibile selezionare uno dei dispositivi ed
impostarlo come Controller predefinito, tramite il tasto destro del mouse
(selezionare l'opzione “Set as Controller”). Con questa operazione il
collegamento al Controllore verra eseguito automaticamente. In alternativa
€ possibile impostare manualmente i dati relativi al Controllore (par.6.2)

6.2 - COLLEGAMENTO ALL'UNITA' INTELLIGENTE

Selezionare il menu “Settings -> Controller’ , si apre la finestra “Settings”
(Fig.6.2)
Impostare i parametri relativi al dispositivo:

Node ID numero identificativo del nodo Modbus (7 + 247)
Channel Canale di comunicazione (Ethernet o porta seriale)
IP Address Indirizzo IP del modulo

Port : Porta riservata del socket Modbus/TCP (502 per i
collegamenti diretti)

Timeout Timeout di ricezione dei pacchetti TCP

Al termine, premere OK.

Premere il pulsante “Connect’ (Fig.6.3-A): se il collegamento va a buon fine,
verra visualizzato il messaggio “Connected” nella barra di Stato (Fig.6.3-B)
nel terminale Log (Fig.6.4); in caso contrario, fare riferimento alla sezione
“Throubleshooting” per risolvere il problema.

Da questo momento, tutti i comandi di lettura, scrittura programmazione e
debug verranno inviati al solo controller specificato. Qualora fosse
necessario collegarsi ad un altro controller, occorre modificare le
impostazioni nella finestra “Settings” e premere di nuovo il pulsante
“Connect’: il Controller precedente verra disconnesso e verra connesso il
nuovo Controller.

6.3 - DOWNLOAD DEL PROGRAMMA

Dopo aver creato I'applicativo, se la compilazione & andata a buon fine, &
possibile scaricare il programma compilato nella memoria interna del
Controllore. Premendo il pulsante “Download” (Fig.6.5-A), si aprira la finestra
“Download” (Fig.6.6). Le operazioni di Download sono possibili solamente in
configurazione “Debug” (fare riferimento alla sezione “Modalita Debug”).

E' possibile selezionare una o piu opzioni:

» “Download Program” (Fig.6.6-A) — Scarica il programma nella memoria
RAM del Controllore.

* “Verify” (Fig.6.6-B) — Confronta il programma caricato nella memoria RAM
del Controllore con il programma compilato.

» “Save in Flash” (Fig.6.6-C) — Scrive il programma caricato nella memoria
RAM del Controllore sulla memoria Flash interna.

 “Clear Register Memory” (Fig.6.6-D) — Azzera i valori dei registri General
Purpose interni al Controllore.

* “Run After Download’ (Fig.6.6-E) — Al termine del download, imposta il
Controllore in Run (esegue il programma).
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6. Operazioni sul Controllore

6.4 - MODALITA' DEBUG

In fase di sviluppo dell'applicativo, se il Controllore & collegato, per attivare
la modalita Debug premere il pulsante “Debug” (Fig.6.6-A).
Nella barra di Stato verra indicato “Debug Mode” (Fig.6.6-B) € verranno
attivati i pulsanti che permettono di effettuare le operazioni di debug:
* “Run’” (Fig.6.6-C) — Esegue il programma in continuo
 “Run To Break” (Fig.6.6-D) — Esegue il programma fino al prossimo
BreakPoint
* “Pause” (Fig.6.6-E) — Interrompe l'esecuzione del programma (se in Run) /
Avanza di uno step (se in Stop)
» “Animate” (Fig.6.6-F) — Visualizza I'andamento del flusso del programma,
avanzando automaticamente di uno step alla volta.

“Stop” (Fig.6.6-G) — Blocca il programma e riporta la posizione al primo
comando (reset)

E' quindi possibile seguire il flusso del programma, leggendo in tempo reale
lo stato del Controllore e dei registri interni. Quando il programma viene
interrotto, viene aggiornata automaticamente la tabella dei registri. La
posizione del programma (blocco funzione da eseguire) viene indicata con
I'indice del blocco funzione in rosso e viene aggiornato il valore PC
("Program Counter”) (Fig.6.7-A).

Nella finestra “Settings” (Fig.6.8), accessibile dal menu “Settings -> Debug” €
possibile impostare le opzioni per la modalita Debug:

* “Run-Time Register Update” (Fig.6.8-A) — Se attivato, in condizione di Run il
software aggiorna automaticamente la tabella dei registri (1 lettura al
secondo)

* “Animate Time” (Fig.6.8-B) — Imposta il tempo di avanzamento tra uno step
ed il successivo per la modalita “Animate”.
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6.5 - MODALITA' RELEASE

Terminata la fase di sviluppo e Debug, € possibile passare alla modalita
“Release”, premendo il pulsante “Release” (Fig.6.9-A).

Nella barra di Stato verra indicato “Release Mode” (Fig.6.9-B) € verranno
disattivati i pulsanti delle seguenti operazioni di debug e download.

In modalita Release, all'accensione il Controllore si impostera
automaticamente in condizione di Run, caricando nella memoria RAM il
programma salvato nella memoria Flash interna.

In modalita Release € comunque possibile leggere o scrivere i registri
interni del Controllore.

6.6 - MODALITA' INIT

La modalita INIT pud essere utilizzata in caso di perdita accidentale della
configurazione, per impostare il Controllore in una condizione di default, per
poter ripristinare la configurazione desiderata. In questa modalita, il
Controllore impostera automaticamente il valore dei seguenti parametri,
indipendentemente dalla programmazione salvata in Eprom:

* Indirizzo IP Assegnato automaticamente dalla Rete tramite un
server DHCP
» Nodo Modbus 0x0Ah (10)

* PORT 0 (Slave) Baud-rate = 9600 bps

In questa modalita, non & possibile I'esecuzione (Run) dell'applicativo e le
funzioni di Debug sono disabilitate. Sono invece permessi il download
dell'applicativo, la lettura e la scrittura dei registri interni ed & abilitata la
funzione di Gateway.

'-II---II---II---II---II---II---II---II-
IATTENZIONE: !
- In_modalita Debug, all'accensione il Controllore si impostera !
lautomaticamente in condizione di Stop, senza caricare il programma e i
Isenza eseguirlo. Per questo motivo, al termine delle operazioni di Debug, I
Ioccorre impostare il Controllore in modalita Release. I

In _modalita INIT, non & possibile I'esecuzione (Run) -
IdeII appllcatwo e le funzioni di Debug sono disabilitate. Sono invece i

permessi il download dell'applicativo, la lettura e la scrittura dei registri
-interni ed & abilitata la funzione di Gateway. 1
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|
6.7 — WEB SERVER

Tramite un Web Browser & possibile visualizzare alcune pagine web
contenute nella sezione Web Server del Controllore.

Per collegarsi alle pagine web, occorre scrivere nella barra dei collegamenti
l'indirizzo IP del Controllore a cui si vuole accedere: I'esempio seguente
mostra come collegarsi alla pagina Index del Controllore con indirizzo IP
192.168.1.100:

http://192.168.1.100/index.htm

Dalla pagina Index (Fig.6.10) € possibile accedere alle seguenti pagine:

Configuration (Fig.6.11) (http://192.168.1.100/protect/config.htm):
permette di modificare le impostazioni lato TCP (indirizzo IP, Subnet
mask, Gateway, ecc...). Premento il pulsante “Save Config”, i parametri
impostati verranno salvati in Eprom ed il Controllore verra resettato.
Questa pagina €& protetta da password (di default, i moduli vengono
configurati con User e Password vuoti). E' possibile modificare User e
Password per questa pagina.

ATTENZIONE! : in caso di smarrimento della Password, non sara
possibile recuperare le informazioni da parte dell'utente.

Dynamic Var (Fig.6.12) (http:/192.168.1.100/dynvar.htm):
in questa pagina vengono visualizzati i valori dei registri interni da %R26
a %R41. Aggiornare la pagina (F5) per aggiornare il valore dei registri.
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Host Name: ATEXEL

IP Address: 92 168.1.172

Gateway: 92.168.1.1
Subnet Mask: 55255 255.0

Primary DNS:
Secondary DNS: 92.168.1.1

Socket Timeout:

user:
Password:

Save Config
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I ———————
Dev9K 7. Consigli e suggerimenti

7.1 - COLLEGAMENTO LATO ETHERNET

Dal lato Ethernet, il Controllore & assimilabile ad un Server, quindi per il
collegamento all'interno della rete LAN é sufficiente seguire le norme
standard dei collegamenti Ethernet. Di seguito vengono riportati alcuni
consigli pratici per il collegamento al Controllore.

Per collegare il Controllore direttamente ad un PC, utilizzare un cavo
incrociato (Crossover).

Per collegare il Controllore ad un Hub, Switch o Router, utilizzare un cavo
diretto.

Alcuni Firewall possono impedire il collegamento al Controllore, in
particolare per quanto riguarda la Ricerca: in caso di problemi di
collegamento si consiglia, se possibile, di disattivare eventuali Firewall attivi
sul PC Client o sul Router.

Qualora non si utilizzi il servizio DHCP (assegnazione dinamica
dell'indirizzo IP) € bene accertarsi che Indirizzo IP, Subnet Mask e Gateway
del Controllore siano compatibili con quelli della rete LAN nella quale &
inserito.
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8.1 — MESSAGGI DI ERRORE NELLA FINESTRA LOG E NELLA BARRA DI STATO

EVENTO

CAUSE

POSSIBILI SOLUZIONI

“Non Connesso”.

-1l Controllore non & connesso.
-Non & stato possibile abilitare il canale di
comunicazione selezionato.

-Verificare nel menu Settings:
per Canale Porta Ethernet:
-Indirizzo IP
-Numero di porta riservata al socket
Modbus TCP (Port)
-Valore del Time out
-Indirizzo Modbus del modulo.
per Canale Porta seriale (COM):
-Numero di porta COM
-Velocita di trasmissione (Baud rate)
-Indirizzo Modbus del modulo.

“Com Error”.

-Errata impostazione dei parametri di
comunicazione della porta Ethernet.
-Errata impostazione dei parametri di
comunicazione della porta Slave.
-Indirizzamento di comando errato sulla
porta Master.

-Verificare nel menu “Settings”™
per Canale Porta Ethernet.
-Indirizzo IP
-Numero di porta riservata al socket
Modbus TCP (Port)
-Valore del Time out
-Indirizzo Modbus del modulo.
per Canale Porta seriale (COM):
-Numero di porta COM
-Velocita di trasmissione (Baud rate)
-Indirizzo Modbus del modulo.

-Verificare nel menu “Config”:

- Indirizzo Modbus del modulo.

- Velocita di trasmissione (Baud rate)
- Delay di ricezione (porta Slave)

Se i parametri sono corretti controllare
che il modulo sia collegato correttamente.

“Com Timeout”.

-Con canale di comunicazione configurato,

indica una mancata ricezione della
risposta da parte del modulo.
-Parametri di comunicazioni errati.

-Verificare nel menu “Settings”™
per Canale Porta Ethernet:
-Indirizzo IP
-Numero di porta riservata al socket
Modbus TCP (Port)
-Valore del Time out
-Indirizzo Modbus del modulo.
per Canale Porta seriale (COM):
-Numero di porta COM
-Velocita di trasmissione (Baud rate)
-Indirizzo Modbus del modulo.

“Label error”.

-Presenza di uno o piu errori all'interno di
un Blocco Funzione componente il
programma che viene rilevato al momento
di eseguire una operazione di
compilazione, di download o di verifica del
programma.

-Controllare i parametri dei Blocchi
Funzione corrispondenti al numero di
indice visualizzato (riferimento sezione
2.3e4.2).
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8. Messaggi di errore

8.2 - MESSAGGI DI ERRORE ALL'INTERNO DI FINESTRE POP-UP

EVENTO

CAUSE

POSSIBILI SOLUZIONI

“Controllore non connesso”.

-1l Controllore non & connesso.
-Non & stato possibile abilitare il canale di
comunicazione selezionato.

-Verificare nel menu Settings:
per Canale Porta Ethernet:
-Indirizzo IP
-Numero di porta riservata al socket
Modbus TCP (Port)
-Valore del Time out
-Indirizzo Modbus del modulo.
per Canale Porta seriale (COM):
-Numero di porta COM
-Velocita di trasmissione (Baud rate)
-Indirizzo Modbus del modulo.

“Timeout”.

-La comunicazione non & andata a buon
fine in quanto il Controllore non ha fornito
una risposta corretta.

-Verificare nel menu “Settings”™
per Canale Porta Ethernet.
-Indirizzo IP
-Numero di porta riservata al socket
Modbus TCP (Port)
-Valore del Time out
-Indirizzo Modbus del modulo.
per Canale Porta seriale (COM):
-Numero di porta COM
-Velocita di trasmissione (Baud rate)
-Indirizzo Modbus del modulo.

-Verificare nel menu “Config”:
-Indirizzo Modbus del modulo.
-Velocita di trasmissione (Baud rate)
-Delay di ricezione (porta Slave)

Se i parametri sono corretti controllare
che il modulo sia collegato correttamente.

“Risposta Errata (funzione)”.

-l modulo slave interrogato tramite il
Controllore non ha fornito una risposta
corretta.

-Verificare nel menu “Config”:
-Indirizzo Modbus del modulo slave.
-Velocita di trasmissione modulo Slave
(Baud-rate)

-Delay di ricezione (modulo Slave)
-N°Bit di Stop, tipo di Parita

-N°di registri letti o scritti

-Codice funzione Modbus trasmesso
-Delay di ricezione (porta Master)

“Controllare valori”.

-Uno o piu parametri inseriti in un Blocco
Funzione non sono corretti; questo errore
appare nel momento in cui si preme il
tasto “OK” per inserire il Blocco Funzione
all'interno del programma.

-Controllare i parametri del Blocco
Funzione: per le funzioni di lettura e
scrittura esterne fare riferimento al data-
sheet tecnico del modulo Slave in uso.
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9.Troubleshooting

9.1 — POSSIBILI CAUSE DI MALFUNZIONAMENTO

EVENTO

POSSIBILI CAUSE

POSSIBILI SOLUZIONI

Mancata accensione del Controllore.

-l Controllore non & stato alimentato
correttamente.

-l valore della tensione di alimentazione
¢ inferiore al valore minimo di specifica.

-Fare riferimento al data-sheet relativo al
Controllore in uso e verificare le relative
Specifiche Tecniche.

Mancata comunicazione tra il PC Host
ed il Controllore.

-Canale di comunicazione porta Ethernet
non collegato correttamente.

-Canale di comunicazione porta Modbus
Slave non collegato correttamente.
-Dispositivo di interfaccia tra PC e
Controllore non collegato correttamente.
-Parametri di comunicazione errati.

-Fare riferimento alla sezione 7.1

-Fare riferimento ai data-sheet relativi al
Controllore ed al dispositivo di interfaccia
in uso.

-Fare riferimento alla sezione 8.1 .

Mancata comunicazione tra il
Controllore ed uno o pia moduli Slave.

-Canale di comunicazione porta Modbus
Master non collegato correttamente.
-Dispositivo Slave non alimentato
correttamente.

-Dispositivo Slave non collegato
correttamente sulla linea seriale RS-485.
-Parametri di comunicazione errati.

-Gli indirizzi dei moduli Slave collegati non
rientrano nell'intervallo impostato nel
registro di sistema Gateway Mask %S17.

-Fare riferimento alla sezione 8.1

-Fare riferimento ai data-sheet relativi al
Controllore ed ai dispositivi Slave in uso.
-Dispositivo Slave in condizione di INIT e
baud-rate di comunicazione € diverso da
9600 bps.

-Verificare i valori di Gateway Mask.

Mancata esecuzione o esecuzione
errata dell’Applicativo.

-Parametri di comunicazione errati.
-Controllore in modalita Debug ed in
condizione di Halt, Stop o Break Point.
-Formato dati dei Registri errato.
-Parametri dei Blocchi Funzione errati.
-Controllore in condizione di Stack
Overflow.

-Parametri di funzionamento degli
eventuali moduli Slave collegati non
inseriti correttamente.

-Non & stato eseguito il download del
programma.

-Controllore in modalita INIT.

-Fare riferimento alla sezione 8.1
-Impostare il Controllore in modalita
Debug ed in condizione di Run oppure in
Modalita Release.

-Togliere eventuali Break Point.
-Impostare il corretto formato dei Registri.
-Verificare i parametri dei Blocchi Funzio-
ne(formato dati, maschere, tabelle, etc..).
-Controllare nel programma la corrispon-
denza Call / Return;

-Controllare la programmazione dei mo-
duli Slave ( tipi di ingresso ed uscita, etc.)
-Eseguire il download del programma.
-Togliere il Controllore dalla modalita INIT

Non si conosce la configurazione del
Controllore

-Impostare il Controllore in modalita
“INIT”; i parametri di configurazione del
Controllore saranno forzati ai valori
predefiniti elencati nella sezione 6.6 .

Si é collegato il Controllore in modalita
“INIT” ma questa non viene eseguita
(dove previsto il Led “STS” non
lampeggia) o non avviene la comunica-
zione tra PC Host e Controllore.

-Controllore non collegato correttamente.
-Baud Rate porta Slave errata.

-Controllare che il morsetto INIT sia colle-
gato al al terminale GND.

-Spegnere e riaccendere il Controllore
dopo aver collegato il morsetto di INIT.
-Impostare Baud-rate porta Slave a 9600
bit/sec.

Mancato funzionamento o non corretto
funzionamento delle funzioni orologio
e calendario(dove previste).

-Batteria scarica o assente.

-Parametri orologio e calendario non
impostati in modo corretto negli appositi
Registri.

-Sostituire batteria
-Controllare parametri dei registri di
Sistema (riferimento a sezioni 3.3 e 3.4)

La funzione “Cerca” non trova nessun
Controllore.

-Non ci sono Controllori connessi.

-1 Controllori non sono collegati
correttamente.

-1 Controllori connessi sul canale di
comunicazione Ethernet sono impostati
con parametri di comunicazione non
compatibili con l'interfaccia Ethernet del
PC Host in uso.

-Sulla rete sono presenti Firewall o Router
che bloccano l'accesso al Controllore.

-Fare riferimento al data-sheet relativo al
Controllore in uso e verificare le relative
Specifiche Tecniche.

-Verificare parametri interfaccia Ethernet
del PC Host.

-Contattare 'Amministratore di Sistema al
fine di poter permettere l'inserimento del
Controllore nella rete.

S VIV R0 Pag. 27



Dev9K

9.Troubleshooting

EVENTO

POSSIBILI CAUSE

POSSIBILI SOLUZIONI

La funzione “Cerca” non trova nessun
modulo Slave.

-Non ci sono moduli Slave connessi.

-1 moduli Slave non sono collegati
correttamente.

-Non si ¢ selezionato il Controllore cui
sono collegati i moduli Slave;

-Gli indirizzi dei moduli Slave collegati non
rientrano nell'intervallo di ricerca indirizzi
impostato nel menu' cerca o nel registro

di sistema Gateway Mask %S17.

-1l baud-rate dei moduli Slave collegati
non corrisponde a quello impostato per
la porta Master del Controllore.

-Valori dei Timeout non corretti

-Fare riferimento al data-sheet relativo ai
moduli Slave in uso e verificare le relative
Specifiche Tecniche e collegamenti.

-Verificare che il Controllore selezionato
sia quello cui sono realmente collegati i
moduli Slave.

-Verificare la corrispondenza tra indirizzi
Modbus moduli Slave.

-Verificare i valori di Gateway Mask.

-Controllare i parametri baud-rate e delay
dei moduli Slave collegati.

Le pagine Web non vengono caricate.

-Non si & inserito il corretto indirizzo IP
del Controllore nella barra indirizzi
dell'Internet browser.

-1 Controllori connessi sul canale di
comunicazione Ethernet sono impostati
con parametri di comunicazione non
compatibili con l'interfaccia Ethernet del
PC Host in uso.

-Sulla rete sono presenti Firewall o Router
che bloccano I'accesso al Controllore.

-Verificare che l'indirizzo IP inserito nella
barra indirizzi dell'Internet browser sia lo
stesso del Controllore.

-Verificare parametri interfaccia Ethernet
del PC Host.

-Contattare 'Amministratore di Sistema al
fine di poter permettere l'inserimento del
Controllore nella rete.

I dati salvati come costanti nella
tabella registri non vengono salvati allo
spegnimento del Controllore.

-1 dati sono stati salvati in Registri General
Purpose e non in Registri Ritentivi.

-Salvare i valori costanti nei Registri
Ritentivi.
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